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Downloading Exercise Files 
Exercise files can be downloaded from the Cheryl Price web site as follows: 
 

  

 

1 In your web browser, type: www.cherylprice.co.nz 

2 Press Enter on the keyboard to display the Cheryl Price website. 

3 
Click in the Product Search box and type the number of this unit 
standard, as shown at the right. 

4 Click on     

5 Click on   

6 

Under the Exercise Files heading click on the underlined blue hyperlink, ie     

Book Exercise Files - V6 Word 2010  Free Download 
The File Download dialog box will display.   

7 If you have Winzip use the following instructions otherwise move to step 8. 

 a   Click on  .    

 
b   Click on the  of the  button. 

 c  If My Documents folder is not displayed click on Set default unzip folder at the bottom of 
the list.  Ensure My Documents is selected then click on Select Folder. 

 d    Click on the  of the  button and click on the My Documents folder.  The files will 
be unzipped. 

8 Click on and ensure My Documents folder is displayed.  Click on  

9 
Click on Open Folder which will display My Documents folder.  Right click on the zipped 
exercise file and select Extract All. Click on Extract.  A folder will be created containing the 
exercise files.   

US 112/108 

US 112/108 
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Changing Defaults 
Default settings may have already been changed in your Word 2010 program.  If not, you can use 
the following instructions to change these. 

Font and Font Size 
You can check if the font and font size have been changed by looking  at the Font box on the 
Home tab.  If it shows  then it has not been altered.  Change the default font to 
Arial 11 pt as follows: 

1 Click on the Font Dialog Box Launcher  which will display the 
Font dialog box. 

2 Change the Font: to Arial and the Size: to 11 pt. 

3 Click on . 

4 Ensure the following option is selected for the font to be applied to All documents based on 
the Normal template.  

 
5 Click on OK then on OK from the Font dialog box. 

Spacing 
Click on the Page Layout tab and if 10 pt Spacing After is displayed as shown at the 
right then this has not been altered.  Remove 10 pt spacing as follows. 

1 Click on the Paragraph Dialog Box Launcher  which will display the 
Paragraph dialog box.   

2 Change the Spacing After: to 0 pt as shown at the right.  

3 Click on .  Ensure All documents based on the Normal template is 
selected then click on OK.  Click on OK from the Paragraph dialog box. 

Margins 
Click on the Page Layout tab then click on the Page Setup Dialog Box Launcher 

 which will display the Page Setup dialog box.  If margins are 
displayed as 3.17 cm change them as follows.  (If they have been changed, click on Cancel.) 

1 The Top: margin will be selected, ie .  Type:  2.54 then press the Tab 
key.  Repeat this until the margins are displayed as shown below. 

. 

2 Click on .  Ensure All documents based on the Normal template is selected then 
click on OK.  Click on OK from the Paragraph dialog box. 
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Unit Standard 112 (Version 6) 
Produce business or organisational information using  

word processing functions  
 

 

Level 3 Credits 5 

 

Purpose People credited with this unit standard are able to: apply 
word processing features and functions to produce business 
or organisational information; and apply file management 
and printing techniques to manage document production. 

 

Classification Business Administration > Business Information 
Processing 

 

Available grade Achieved 

 

Entry information 

Recommended skills 
and knowledge 

Unit 111, Use a word processor to produce documents for 
a business or organisation 

 
 
Explanatory notes 
 
1 All activities associated with this unit standard must comply with occupational 

health and safety guidelines and recommendations in relation to working 
environment and work practices.  Reference for this unit standard includes OSH 
3211 AFC: 1996 Approved Code of Practice for the use of Visual Display Units 
in the Place Of Work.  Occupational Safety and Health Service: Department of 
Labour, available at http://www.osh.govt.nz/order/catalogue/pdf/vdu-ac.pdf. 

 
2 Logical structures such as folders must be used to organise and store files 

according to business or organisational requirements. 
 
3 Business or organisational information requires the production of six different 

types of documents which may include but are not limited to – legal, financial 
and technical documents; formal reports; formal meeting documents; 
promotional brochures; forms for completing electronically and/or manually. 

 
4 Spelling, grammar, vocabulary, and punctuation in the documents must be 

consistent with the nature and purpose of the business or organisational 
information required.  Candidates must be given the opportunity to proofread their 
work prior to submission.  
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Outcomes and evidence requirements 
 
Outcome 1 
 
Apply word processing features and functions to produce business or organisational 
information. 
 
Evidence requirements 
 
1.1 Display and formatting features are applied to present documents in 

accordance with the output required and organisational style requirements. 
 

Range features include but are not limited to – page numbering 
options, page and section breaks, page layout, header and 
footer features, font selection and size, text format, use of 
lines, boxes, borders, alignment, columns including 
hyphenation, bullets and numbering. 

 
1.2 A template is used and variable data is inserted in accordance with the 

output required. 
 
1.3 A mail merge is created in accordance with the output required. 
 
1.4 Sorting options are applied in accordance with the output required. 
 
1.5 Tables are produced incorporating multiple line headings, ruled and non-

ruled columns, and a range of column widths in accordance with the output 
required. 

 
Outcome 2 
 
Apply file management and printing techniques to manage document production. 
 
Evidence requirements 
 
2.1 Access to word processing files is controlled through the implementation of 

file management system procedures. 
 

Range password protection, login procedures, document storage, 
and file back up and/or copying procedures; 
evidence of three procedures is required. 

 
2.2 The creation of folders and movement between them are consistent with file 

management system procedures. 
 
2.3 File types are differentiated in accordance with file management system 

procedures. 
 

Range document, template. 
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2.4 Print options are identified and used in accordance with system features 
and output required. 

 
Range may include but are not limited to – selected text, single page, 

multiple pages, entire document, print preview, duplex 
printing; 
evidence of three is required. 

 
2.5 Printer capability and settings are identified and, where available, an 

alternative printer is selected. 
 
2.6 Paper loading and print cartridge changing operations are carried out in 

accordance with equipment guidelines and organisational requirements. 
 

Planned review date 31 December 2015 

 
Status information and last date for assessment for superseded versions 
Process Version Date Last Date for Assessment 
Registration 1 30 March 1993 December 2011 
Review 2 27 June 1996 December 2011 
Review 3 28 April 1997 December 2011 
Review 4 28 June 1999 December 2011 
Review 5 26 September 2005 December 2012 
Review 6 17 December 2010 N/A 
 
Accreditation and Moderation Action Plan (AMAP) reference 0113 
This AMAP can be accessed at http://www.nzqa.govt.nz/framework/search/index.do. 
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xii 

Unit Standard 108 (Version 6) 
 

Title Apply text processing skills to produce business documents 

Level 3 Credits 5 

 

Purpose People credited with this unit standard are able to apply text 
processing skills to produce business documents. 

 

Classification Business Administration > Business Information Processing 

 

Available grade Achieved 

 

Entry information 

Recommended skills 
and knowledge 

Unit 107, Apply text processing skills to produce 
communications in a business or organisational context 

 
Explanatory notes 
 
1 All activities associated with this unit standard must comply with occupational 

health and safety guidelines and recommendations in relation to working 
environment and work practices.  Reference for this unit standard includes OSH 
3211 AFC: 1996 Approved Code of Practice for the use of Visual Display Units 
in the Place Of Work.  Occupational Safety and Health Service: Department of 
Labour, available at http://www.osh.govt.nz/order/catalogue/pdf/vdu-ac.pdf. 

 
2 Definition 
 Text processing conventions refer to accepted practices of display for page 

layout, font selection and size, spacing, use of lines, boxes and borders, and 
white space.  Conventions used must produce documents that are fit for their 
intended use and meet organisational style requirements. 

 
3 Evidence of text processing skills must include the following features which may 

be demonstrated once over all five business documents rather than in each – 
amendments made from both printed and hand-written annotations, use of 
calculations, business terms and abbreviations, numbers, columns, tables, simple 
boxes and/or borders. 

 
4 Spelling, grammar, vocabulary, and punctuation in the documents must be 

consistent with the nature and purpose of the business or organisational 
information required.  Candidates must be given the opportunity to proofread their 
work prior to submission. 

Outcomes and evidence requirements 
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xiii 

 
Outcome 1 
Apply text processing skills to produce business documents. 
Range: business documents may include but are not limited to – business 

correspondence, financial reports, meeting documents, formal reports, 
travel documents, promotional and advertising material, entertainment and 
social information, forms; 

 evidence is required for five different types of business documents. 
  
Evidence requirements 
1.1 Spelling, grammar, vocabulary, and punctuation are consistent with the 

nature and purpose of the business documents required. 
1.2 Page layout, format and display of business documents are consistent with 

the output required, and meet organisational style requirements. 
1.3 Business documents are composed from annotated drafts containing 

extensive editorial amendments, in accordance with information provided 
and output required. 

1.4 Information is listed in sequence in accordance with the information 
provided and output required. 
Range: chronological, alphabetical, numerical. 

1.5 Business documents are processed and presented within a specified time 
frame in accordance with information provided and output required. 

1.6 Business documents are produced in accordance with text processing 
conventions. 

 

Planned review date 31 December 2015 

 
Status information and last date for assessment for superseded versions 
Process Version Date Last Date for Assessment 
Registration 1 30 March 1993 December 2011 
Review 2 27 June 1996 December 2011 
Review 3 28 April 1997 December 2011 
Review 4 28 June 1999 December 2011 
Review 5 26 September 2005 December 2012 
Review 6 17 December 2010 N/A 
 
Accreditation and Moderation Action Plan (AMAP) reference 0113 
This AMAP can be accessed at http://www.nzqa.govt.nz/framework/search/index.do. 
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xiv 

Exercise Files used in this book 
(Instructions are at the front of this book for downloading retrievable files from our web site.) 
 

Name of Files 
Achieving Consistency Invoice 
Adelaide Shopping Italy 
Banking Jury Service 
Beads, Seeds and Shells Managing a Mortgage 
Beauty Care McIvers 
Bertrams Letterhead MemoForm 
Book Sales Merge-Data 
Cairns Merge-Main 
Canterbury Tours Motor Homes 
Care of a New Puppy Mouse 
Caring for your Carpet Numbering Exercise 
Cashflow Numbering  
Cherry Venture Otaki Tramping Club 
China Pacific Hotels Letterhead 
Choosing a Cat Paris in the late 19th Century 
Costello Parkvale Letterhead 
Credit Note Parkvale Memo 
Departments Pinetree Invoice 
Dining Out Pinetree Letterhead 
Dinos Planning a Wedding 
Dr Bradley Letterhead Posture 
EAL Letterhead Proof reading-test 
EAL Memo Rafting 
Email List Rata Motor Camp Ltd Newsletter 
Email Sales 
Ergonomics1 Send-a-Basket-test 
FaxForm Shareholders Report – 2011 
Fitness Equipment Show Jumping 
Formats-test Sort List 
Good Food News Sorting Assessment 
Healthcare Insurance Sorting Exercises 
Holland Sightseeing Sparkling Pools 
Statement Tour and Event 
Suncare Travel Confirmation 
Tables-test Travel Itinerary 
Tasty Icecream Letterhead Triathlon 
Toastmasters Flyer Xmas Gifts 
Toastmasters  
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Ergonomics, Revision 
Tabs, Indenting 
Bullets and Numbering 
 

 
 

 
Learning Outcomes 
 
At the end of this section you should be able to -  
 
 
 Understand and apply ergonomics procedures 

 Revise –  
Correction Signs, Moving and Copying Text, Spelling and Grammar,  
Vertical Centring, Page Numbering, Paragraph Numbering, Sorting,  
Format Painter, Paragraph Spacing, Repeat 

 Set and adjust tab settings 

 Indent paragraphs 

 Use Bullets and Numbering options 

Section 

1 
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Introduction 

The Appendix in this book contains a summary of Word features and instructions, and theory such 
as Punctuation and Vocabulary, Correction Signs, Words Commonly Confused etc which can be 
used for reference purposes. 

A Practice Assessment is included at the end of each section where students should show 
consistency and proficiency in layout of each of the documents.  Your tutor will specify the time 
frame for completion of these tasks on the first page of each Practice Assessment. 

 
Instructions in this manual will cover Word 2010 and will be displayed as shown below. 

To change left and right margins - 

1 Click on the  tab at the top of the screen. 

2 Click on the Page Setup Dialog Box 
Launcher as shown at the right, to display the 
Page Setup dialog box. 

3 In the Margins section, type in measurements in the Left: and Right: boxes. 

4 Click on OK. 

Alternatively  
Left and right margins can be changed on screen by positioning the mouse pointer between the 
indent markers (changes to a black horizontal arrow) on the horizontal ruler and dragging to the 
left or right. 

The top margin can be changed by moving the mouse pointer to the top of the vertical ruler 
(where the grey top margin meets the ruler) and dragging upwards or downwards.  The bottom 
margin can be altered in the same way.   
 
 

 

 

 

 

 

 

 

 

 

 
        

Mouse 

 Printer 
System Unit   

Keyboard  

Monitor 

Page Setup Dialog Box 
Launcher 
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What is Ergonomics? 
Ergonomics is the study of the efficiency, comfort and safety of people in their working 
environment.  In the office/computing sector, the field of ergonomics plays an important role in 
the production of monitors, keyboards and furniture, specifically in ensuring good design 
techniques that avoid the cause of backaches and muscle cramps.   

Learning how to sit at a desk and use your computer in an ergonomically sound manner will 
reduce the risk of health problems and ensure that you are comfortable in your working 
environment. 

The New Zealand Department of Labour has published an approved Code of Practice for the use 
of Visual Display Units covering all of the ergonomic factors that should be considered in a 
workplace.  This is available on the Resources tab of our web site at www.cherylprice.co.nz under 
the heading of Free Resources. 
 

 

 

Ergonomic Computer Equipment 

Monitor  

The monitor should be positioned so that it is straight in front of the operator, an 
arm’s length (40cm - 90cm) away from the eyes.  The top of the viewing area of 
the screen should be just below eye level and the screen should be tilted so that the 
operator looks slightly downwards onto the screen.  The height of the monitor 
should be adjustable; this may require using a monitor stand to ensure it is at the 
correct height. 
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Anti-glare Screens and UV Filters 

Where a computer monitor is located near a window or lights, glare can commonly be a problem, 
causing eyestrain or headaches.  Many modern computer screens incorporate an anti-glare surface.  
For older computers, an anti-glare screen can be positioned over the monitor to reduce or 
eliminate the problem. 

Most anti-glare screens incorporate a filter which protects from ultra-violet (UV) radiation.  CRT 
monitors emit a small amount of UV radiation (and there is significant debate as to the danger or 
otherwise of this exposure).  LCD monitors do not emit a measurable amount of radiation. 
 
Copy-holder 

A copy-holder (also called a document holder) is used to position documents so 
they can be viewed easily while typing.  A well positioned copyholder reduces 
the need to bend the neck.  There are various types of copyholder; the most 
common are free standing devices which are positioned beside the computer 
screen.  Others can be attached to the side of the monitor. 
 
Keyboard   
While there are many different types of keyboard, all keyboards should have the following 
attributes: 

 They should be thin; the ‘asdf’ row should be 30mm or less in height. 
 The slope should be between 0° and 15° and should be adjustable. 
 The keys should be sensitive enough so that they do not need to be hit hard. 
 They should make a clicking noise when the key is pressed successfully. 

 
 
To ensure the keyboard is correctly positioned on the workstation, place your hands over the 
centre of the keyboard and check the following: 

 Your forearms are parallel with the ground. 
 Your elbows are at a 90° angle (forming an L shape between the upper and lower arms). 
 Your fingers rest over the ‘asdf’ row and all keys are able to be reached without stretching the 

fingers or forearms. 
 Your wrists are not raised or bent in an unnatural angle. 
 Your elbows are tucked in neatly by your sides. 
 Your fingers are curved in a natural position. 
 

Keyboard Wrist Rest 

The purpose of a wrist rest is to support the wrists in a natural, 
comfortable position.  This is an important ergonomic consideration 
for many people who experience pain or tiredness in their wrists 
when using a keyboard.  The wrist-rest is positioned in front of the 
keyboard.  Some keyboards have built-in wrist rests. 

Built-in wrist rest 
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Mouse 

The mouse needs to be positioned so that the operator can move it without 
having to stretch their arm.  It should be placed on a flat surface such as a 
specifically designed mouse pad, which allows it to be moved easily. 

The mouse should be shaped so that the hand rests on it comfortably.  The 
buttons should be able to be used without cramping the hand.  The pressure 
required to click the buttons should not be so hard as to make it tiring to use, 
nor so light that they are easily clicked in error.  The mouse movement and 
click speed should be adjustable to suit the individual. 

Some mice are designed specifically with ergonomics in mind.  Wireless mice allow total freedom 
of movement.  Other mice are shaped specifically to fit the hand’s natural shape and provide 
support. 
 

Mouse Wrist Rest 

In the same vein as keyboard rests, there is a huge range of wrist rests 
available to support the wrist while using the mouse.  All are designed 
to keep the wrist in a relaxed, natural position to avoid discomfort and 
injury. 

Some mouse pads come with a built in wrist rest as shown at the right. 
 
Chair 

A well designed, adjustable chair is one of the most important factors in preventing posture 
problems.  Your chair should be adjustable vertically (usually between 450 mm and 520 mm in 
height).  The chair should be at a height where you can sit comfortably with both feet on the floor, 
or on a foot-rest. 

The back rest should be adjustable for height and angle.  The back rest should provide support for 
the lumbar region of the back.  

The recommended seat depth is between 380 and 480 mm.  When seated in the chair you should 
be able to fit one hand-width between the seat and the back of your knee. 
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Position in the Chair 

It is important to sit upright in the chair with your back pushed into the backrest, rather than 
slumped forward over the keyboard.  This will reduce the chance of back and shoulder pain.  
When you are seated in your chair ensure you are sitting at the back, not perched at the edge.  
Ensure your feet are flat on the floor or on a footrest, your shoulders are straight and there is a 
slight curve of the spine in the lumbar region. 

 
Foot-rest 

A foot-rest is useful when the desk and chair cannot be adjusted and can 
be used to ensure proper posture.  Ideally the foot-rest slope should be 
comfortable; 0°-10° is recommended, with a flat surface area of 
350 x 45 mm. 
 
Workstation  

A workstation is simply the desk or table used when working on a computer.  The workstation 
should be deep enough to allow the positioning of the keyboard and monitor correctly.  The work 
surface needs to be big enough to allow the mouse, documents, document holder, and any other 
items which are used regularly (telephone, desk caddy, etc) to be within easy reach.  It should also 
be as thin as practical, preferably less than 2.5 cm, to give maximum knee room.  Ideally the 
height of the workstation should be adjustable to suit the height of the operator.  If it is not 
adjustable a foot-rest may need to be used.  

The equipment on the workstation needs to be arranged so that all equipment can be reached 
comfortably.  Frequently-used items should be within easy reach.  A possible workstation layout is 
shown below. 
 
 

 
 

Workstation Location 
The location of the workstation within an office needs to be chosen with care.  The workstation 
should be positioned at right angles to windows, mirrors or other light sources to help reduce glare 
or reflections.  Power cables need to be able to reach the computer safely, without being stretched 
or lying across access ways.  People need clear access to and around the workstation.  In a large 
office, space or partitions between desks can help to give the illusion of having privacy in one’s 
workspace. 

Localised lighting can be used 
to reduce eye strain. 

Copy-holder positioned 
to side of monitor 

Telephone in easy 
reach 

Mouse and keyboard 
positioned close to user 
so no reaching required  

User can simply turn to 
retrieve documents 
from printer 

Monitor straight in front 
of user Sa
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Physical Exercises 
There are exercises which, when done regularly, can help to prevent OOS.  These exercises are 
designed to reduce muscle tension and increase blood flow. 

   

Side neck stretch Head turn Bi-directional neck stretch 
Slowly tilt your head to one side, 
stretching the side of your neck.  
Return your head to upright and 
repeat on the other side. 

Slowly turn your head to one side.  
Return to centre and repeat on the 
other side. 

Bend your head forward and then 
turn your head to right.  Use your 
right hand to gently pull your chin 
down towards your armpit.  Repeat 
on the other side. 

   

Shoulder Roll  Upper back stretch Upper arm and shoulder stretch 
Lift both shoulders upward toward 
your ears, and then down again 
slowly.  Roll your shoulders gently 
backwards and forwards to ease 
tension in the neck. 

Clasp your hands behind your 
head, keeping your elbows straight 
out to the side.  Gently lean over 
the back of your chair, stretching 
your upper back. 

Bend your right arm placing your 
right hand on your upper back.  
Hold your right elbow with your left 
hand and use this hand to gently 
push your right arm down.  Repeat 
on the other side. 

   

Chest and shoulder stretch Arm and rib cage stretch Finger Spread 
Interlace your fingers behind your 
back.  Gently turn your elbows 
inwards, straightening your arms. 
Pause and then release. 

Interlock your fingers; stretch your 
arms above your head, palms 
upward.  Try to keep your shoulders 
lowered. 

Hold your right arm out bent upward 
at the elbow.  Spread fingers wide 
apart stretching the inner palm and 
fingers.  Repeat on the other side. 

 

 

 

Chair twist Front wrist stretch Back wrist stretch 
Sit in a chair with your left knee 
crossing your right.  Place your right 
hand on the outside of your left 
knee.  Twist and place your left 
hand on the back of the chair.  Hold 
and repeat on the other side. 

Hold your right forearm out straight, 
palm facing up.  Take your fingers 
with your left hand and pull them 
back gently so the front of your wrist 
is stretched.  Repeat on the other 
side. 

Hold your right forearm out bent 
upward at the elbow.  Take your 
fingers with your left hand and pull 
them gently downward so the back 
of your wrist is stretched.  Repeat 
on the other side. 
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Eye Exercises  
To avoid eye strain when using a computer screen do the following. 

 Blink often to prevent the surface of your eyes drying out and becoming irritated.   

 Stare off into space - every now and then look across the room or out the window. 

 Adjust your screen so it is not too bright. 

 Use a glare screen to minimise glare reflected back into your eyes. 

 Wipe the dust off your screen regularly. 

 Use the clock at the right to practise eye exercises (you can also do 
these exercises in greater movements shown in brackets below). 

12 to 6 (from ceiling to floor) 

9 to 3 (from one side of the room to the other) 

1 to 7 

11 to 5 

Now close your eyes for a few seconds, relax and open your eyes.  Begin at 12 and circle 
around to 3, 6, 9 and back to 12 three times. 

Reverse directions, then close your eyes and relax. 

 To release tension in your face around your eyes, close them tightly and gently squeeze, 
allowing your facial muscles to draw up.  Hold for two seconds, relax your face and open 
your eyes, then open your mouth wide while raising your eyebrows.  Repeat three times. 

 

Work Breaks 
Operators should be given frequent breaks away from their terminals in order to avoid eyestrain 
and posture problems.  The recommended break is 10 minutes every hour worked where work is 
screen-intensive.  Try to vary tasks and take a break from your computer to do filing, make 
business phone calls etc. 
 

Micropauses 
A micropause is a short break in work for muscle relaxation.  Specifically, it is a 5-10 second 
break in work for muscle relaxation every three minutes or so.  Micropauses allow for the 
restoration of blood flow to muscles which have been held tense.  It is when the muscles relax 
fully that micropauses are of most value.  They help you be more productive.  A variation to 
exercises is simply to count your breaths. 
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Saving and Printing your Work  
When you have finished typing an exercise it is a good idea to save your work, print it out and 
then check for errors. 

  

Saving 

1 Click on the Save button   on the Quick Access Toolbar  at the top left of 
the screen, OR press Ctrl S. 

2 Type a file name for your document. 

A file name can contain up to 255 characters in the main part of the file name. 

3 Click on Save. 
 
Printing 
1 Click on the File tab in the top left of the screen. 

2 Click on Print, change options as required then click on  OR you can press Ctrl P then 
Enter.  (Quick Print can also be selected from the Quick Access Toolbar.) 

 
Close 

 Click on the File tab then select  OR press Ctrl W. 
 
Exiting from Word 
 Click on the File tab then select  OR press Alt F4. 
 
Shutting down your Computer 
1 Click on the Start button and select Turn off 

Computer. 

2 Select Turn Off. 

  

Remember to save your work often, usually every 10-15 minutes depending on how fast you type 
and how much work you have done.   

Always save - 
 at the end of a page 
 at the end of a document 
 before spell checking or printing 
 before changing to another program.   

Use one of the following. 

Ctrl S, or  
Click on the Save button, or 
Click on the File tab and select Save. 
Saving regularly prevents loss of work due to power failure, when the computer “hangs”, or a 
network crashes.   

Note 
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Customising the Quick Access Toolbar 
The Quick Access Toolbar can be used for your most frequently used commands.  It can be 
customised – commands can be added or removed and the toolbar itself can be positioned either 
above or below the ribbon. 

Quick Access Toolbar List 
 
Exercise 1 
1 In a new document click on the Customize Quick Access 

Toolbar  to the right of the Quick Access Toolbar.  Options 
that can be added are displayed as shown at the right. 

A tick displays to the left of every option that is currently 
displayed on the Toolbar. 

2 Click on New to add it to the Quick Access Toolbar. 

3 Click on the Customize Quick Access Toolbar  again and 
click on Open.   

4 Add the following options to the Toolbar using the same steps. 

Quick Print, Spelling & Grammar  

Additional Quick Access Toolbar Commands 
Some other useful options that are not on the Quick Access Toolbar list can be added using the 
following steps. 
 
Exercise 2 

1 Click on the Customize Quick Access Toolbar   at the right of the Quick Access Toolbar 
and select More Commands… 

The Word Options dialog box will display, with the Quick Access Toolbar option selected.  
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2 Click on the Choose commands from:  and select All Commands.  The commands are 

listed in alphabetical order. 

3 In the list at the left, scroll down until Close/Close All is displayed.  

4 Click on  then click on .   

5 Also add which is Print Preview from Word 2007 (and Word 2003).   

(You can also add Print Preview and Print which is the Word 2010 option if desired.  This 
will be displayed with the same button  but the name will be different.) 

The commands will be added to the Quick Access Toolbar list on the right as shown below. 

 

6 Add other buttons as required, eg AutoText. 

7 Ensure a tick is displayed in the following option at the 
bottom of the dialog box. 

8 Click on . 

The Quick Access Toolbar is now displayed between the ribbon and the ruler as shown 
below. 

 

You can click on the Customize Quick Access Toolbar  and select Show Above the 
Ribbon.  The position that you display the Quick Access Toolbar is entirely up to you.   

It is a more effective option however, to display the Quick Access Toolbar below the ribbon for 
speedy access to the buttons you have added. 

You can add other useful buttons to the Quick Access Toolbar as you progress through this book. 

The ribbon can also be customised by clicking on the File tab, selecting  then 
Customize Ribbon.  Commands can be added/removed in the same way as customising the 
Quick Access Toolbar.  New groups and new tabs can be created. 

 
 

Note 
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Two examples of font and font sizes are: 

This is BrushScript 16 pt font 

This is Arial 14 pt font 
 

Formatting Text 
Text is formatted when you want to change the style, 
increase/decrease the size, colour, apply special 
effects, change alignment and spacing etc. 
 

Fonts 
A font is a style of type.  Fonts can be increased or decreased in size (known as point size or pt).  
Windows has a variety of “OpenType” and “TrueType” fonts that will print with all printers (they 
have  and  next to them on the drop-down list on the Home tab).   

In Word it is quicker to type text, then select it and apply formatting, rather than applying formats 
as you type. 

To apply character formatting to a single word simply click in cursor anywhere within it and 
formatting will be applied to the whole word (ie it is not necessary to select the entire word). 

Once you have selected text, you can apply formatting using either – 
 
Home tab 

 
 

Font dialog box 

 

Font Font Size 

Font Size 

Font 

Click on the Font Dialog Box Launcher 
 from 

the Home tab in the Font group to 
display the Font dialog box. 

Font Dialog Box Launcher 

Grow and Shrink Font 
(increase/decrease font size) 
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